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Donor Acknowledgement Report 

The Advancement Resources website provides the Donor Acknowledgement Report, which lists gifts to WFAA funds 

and detailed information about the donors for each gift. The report’s purpose is to assist those responsible for 

acknowledging donor giving. The report also provides a way to record acknowledgement activity in ABE CRM. 

How Gifts Are Recorded at the WFAA 

Donor and gift information is recorded in ABE CRM, the WFAA database of alumni, donors, and friends. 

Understanding how gift information is stored will assist you when interpreting the Donor Acknowledgement Report. 

Constituents 

Gifts are received from constituents. A constituent is an individual, corporation, organization, group, charitable 

fund, family trust, etc. 

Each constituent has a record in ABE CRM. A constituent record is assigned a unique ID number and contains 

constituent contact information (address, phone number, email). If the constituent is a UW-Madison alumnus, 

their degree information is also stored. 

Revenue 

Revenue is the payment record of a constituent gift. Revenue can be a pledge, a payment against a pledge, an 

outright gift, or a matching gift payment. Revenue is also known as a hard credit. 

In accordance with IRS requirements, revenue must be recorded for the constituent who will receive the tax 

receipt. Consequently, revenue is recorded in only one constituent record. 

When an individual gives a gift, the revenue is recorded in their record. When a couple gives a joint gift, revenue 

is recorded in one of the couple’s records. When a family gives through a family foundation, the foundation is 

credited with the revenue. 

Recognition Credits 

For each gift, recognition credits (also known as soft credits) are recorded for all constituents who are 

responsible for giving the gift. A single gift may have multiple recognition credits. 

When an individual gives a gift, they receive recognition credit in addition to the revenue credit. When a couple 

gives a joint gift, each receives recognition credit, but only one receives the revenue. If a couple gives a gift 

through their family foundation, the foundation and each member of the couple receives recognition credit, and 

the foundation receives the revenue. 
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How Gifts Are Represented in the Donor Acknowledgement Report 

The Donor Acknowledgement Report lists gifts and the constituents (donors) who are given recognition credit for 

them. 

The report provides an abundance of information. A detailed explanation of all data fields is provided in the Donor 

Acknowledgement Report – Data Fields section later in this document. For current purposes, we will concentrate 

on a small set of fields: 

Revenue Transaction ID 

A unique ID assigned to a received payment. 

Recognition Amount 

The recognition credit amount of the gift or pledge. (May differ from the Transaction Amount in cases where 

part of the transaction is not tax deductible. An example is the value of a dinner for an event ticket 

purchase.) 

Constituent ID, First Name, Last Name 

Data about the constituent pulled from the ABE CRM database. Each constituent listed in the report is more 

commonly known as a donor.  

Spouse ID, First and Last Name 

When spouses/partners give a joint gift, this describes the spouse/partner. 

Donor Directed Organization Name 

This field contains data when a gift is made via a company, foundation, or charitable fund. 

The following sections provide examples of different types of gifts and how they are represented in the Donor 

Acknowledgement Report. 

Gift from an Individual 

Chris Jones makes a gift of $100. 

 

Here is the gift in the Donor Acknowledgement Report: 

 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last 
Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13451111 8-10445566 Jones Chris    $100.00  

 

Gift from Spouses/Partners 

The married couple (or couple in a life partnership) Mary and Chris Smith make a joint gift of $100. Here is the gift in 

the Donor Acknowledgement Report: 
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Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last 
Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor 
Directed 

Organization 
Name 

rev-13458888 8-10145566 Smith Mary 8-10496876 Smith Chris $100.00  

Gifts from spouses/partners are represented by a single, combined entry. Each of the spouses/partners has their 

personal information (e.g. name, degrees) included in the entry. 

Criteria to determine Constituent/Spouse: 

 Generally, the Constituent is the one who has been credited with the revenue. 

 You can specify a preference of which donor should be considered the constituent (and not the spouse). See 

the Generating the Donor Acknowledgment Report section below. 

Gift Made Through an Organization, Foundation, Charitable Fund, or Trust 

If Gary Johnson owns ABC Company and makes a gift of $5,000 through the company, here is how the gift will 

appear in the Donor Acknowledgement Report: 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse 
ID 

Spouse 
Last 

Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13469999 8-10779456 Johnson Gary    $5,000.00 ABC Company 

If Gary is married to Lisa Johnson and they make a “joint gift” through the company, here is what appears in the 

report: 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last 
Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13469999 8-10779456 Johnson Gary 8-1329611 Johnson Lisa $5,000.00 ABC Company 

If Gary, Lisa, and Gary’s brother Tom make a gift through the company, here is what appears in the report (note that 

these entries have a matching Revenue Transaction ID): 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last 
Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13469999 8-10779456 Johnson Gary 8-1329611 Johnson Lisa $5,000.00 ABC Company 

rev-13469999 8-10326814 Johnson Tom    $5,000.00 ABC Company 

Tom appears on a separate line because he is not a spouse/partner of Gary nor Lisa. 

Gifts made via organizations, foundations, charitable funds, or trusts are also subject to these revenue and 

recognition rules. In the above examples, you could substitute “ABC Foundation,” “ABC Fund,” or “ABC Trust” for 

“ABC Company”. 

New Pledges and Pledge Balance Amounts 

Pledges made during the reporting period are included in the report. These have a description of New Pledge:  
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Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Gift Type 
Description 

Recognition 
Amount 

Total 
Pledge 

Pledge Balance 
Amount as of 
Report Date 

Final 
Pledge 

Payment 

rev-13862222 8-11123456 Woods Paul New Pledge $1000.00 $1000.00 $1000.00  

 

Here is another example of a new pledge: 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Gift Type 
Description 

Recognition 
Amount 

Total 
Pledge 

Pledge Balance 
Amount as of 
Report Date 

Final 
Pledge 

Payment 

rev-13107654 8-44416111 Brown Meg New Pledge $500.00 $500.00 $0.00  

This entry indicates that the pledge was made during the reporting period (New Pledge). It also shows that at the 

time the report was generated, payments have been received that have fulfilled the pledge (the Pledge Balance 

Amount as of Report Date is $0.00). 

A new pledge and an associated pledge payment may appear in the same report. Here are two examples (the data 

has been sorted by Constituent ID): 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Gift Type 
Description 

Recognition 
Amount 

Total 
Pledge 

Pledge 
Balance 

Amount as 
of Report 

Date 

 
Final 

Pledge 
Payment 

rev-13862222 8-11123456 Woods Paul New Pledge $1000.00 $1000.00 $800.00  

rev-13941874 8-11123456 Woods Paul Pledge Payment $200.00 $1000.00 $800.00  

rev-13107654 8-44416111 Jones Linda New Pledge $50.00 $50.00 $0.00  

rev-13210715 8-44416111 Jones Linda Pledge Payment $50.00 $50.00 $0.00 Yes 

Here we see that within the reporting period Paul pledged $1000 and made a $200 payment toward that pledge. 

Within the same reporting period, Linda pledged $50 and made a $50 payment toward the pledge. Because the 

payment fulfilled the pledge, the Final Pledge Payment field displays ‘Yes’. 

Recurring Gifts 

A Recurring Gift is a commitment from a donor to give regularly. Recurring gifts have no specific end date. When the 

commitment is made, a gift type of Recurring Gift Initiation is included in the report. The Amount field displays the 

expected amount for each gift. If the Amount field is $1.00, the gift amount is “open ended,” and the donor will 

decide the amount at recurrence time. 

Postal mail reminders are sent to the donor at recurrence time. The reminder includes the name of the fund, the 

date of the installment, and the expected amount. (For “open ended” gifts, no amount is included.) 

When a recurring payment is made, a gift type of Recurring Gift Payment is shown. 

No Public Recognition/Anonymous Gifts 

Public Recognition is defined as external or public-facing recognition of a donor’s gift, such as donor walls, honor 

rolls, etc. When a donor prefers to have no public recognition, their gifts are flagged with an anonymous indicator 

on their gift in ABE CRM. If these donors would still like to receive private recognition in the form of thank you notes 
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or acknowledgements, their names will appear in the Excel versions of the Donor Acknowledgement Report on a 

separate tab labeled “No Public Recognition.” In the Web version of the report, the detail view of theiir gifts will 

include a Recognition Preference field with “No Public Recognition.” These new features were made available in 

September 2020, to allow advancement staff to privately acknowledge these gifts.  

Planned Gifts, Matching Gifts Claims, Informational Transactions, “Do Not Acknowledge” 

Gifts 

These gifts are not included in the report. If you have questions about acknowledgement policies for these types of 

transactions, please reach out to your WFAA contact or email your question to the WFAA Help Center 

(help@uwadvancement.org). 
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Links in Report Data 

Every row in the report data displays the Revenue Transaction ID, Constituent ID, Spouse ID, and Fund Number 

fields as hyperlinks: 

 

The links open a browser tab to display detailed information stored in ABE CRM. (The fund information link is 

inoperable to campus users.) If you open multiple tabs and one of them “times out” because of non-use, all ABE tabs 

will time out. 

Attempts to use these fields in mail merges, or to take advantage of some Excel functions (like sorting) may fail. 

This is because the underlying data in these fields is a complex hyperlink, not the simple text displayed. To remedy 

these potential pitfalls, you will need to do a small bit of additional work. 

The simplest approach is to replace the underlying hyperlink data with the displayed values. Here’s how to do it: 

 Do a right-click on the data column containing the hyperlinks. (In the example above, right-click B to select 

the Constituent ID column.) A popup menu will display: 

 
 Select Copy from the popup. 

 Do another right-click on the data column and Paste the values by selecting the second ‘Paste’ icon (the one 

with 123 at the bottom): 

 

This replaces the underlying hyperlink data with the displayed values. (If you would rather not replace the data, you 

could create a new Excel column and paste the data there…but be sure to change the label in the column header!)  
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Advancement Resources Website 

The Donor Acknowledgement Report is generated from the Advancement Resources website. This website provides 

a centralized and secure location to access fund information and generate fund reports. 

Fund List & Information Page 

The first step in generating the Donor Acknowledgement Report is to select one or more funds. This is done from the 

Fund Reporting → Fund List/Information page.  

The resulting Fund List & Information page displays a list of funds: 

 

Click the column headers to sort the funds by values in that column, and use the buttons at the bottom to scroll 

through the fund list. 

Each fund has a View link in the rightmost column. Click the link to see details for a particular fund: financial 

information, a detailed fund description, a list of users who may access the fund information, etc. 

Selecting Funds to Include in the Donor Acknowledgement Report 

Select one or more funds by checking the checkbox in the first column: 
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Filtering the Fund List 

Depending upon your access permissions, the Fund List & Information page may display a large number of funds 

over many pages. You have the ability to filter (limit) the funds to display. Begin by clicking the Filter Fund List 

button. A form will display for you to specify fund criteria: 

  

The fields at the top of the page can be used to find funds by number or name. 
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Use the remaining boxes to select characteristics of the funds you wish to display. To make multiple selections 

within a box, hold down the CTRL key as you select. 

The Begin Date Range fields are optional. You may use them to limit the list based on the date a fund was created. 

By default, only Open funds are listed. Use the Include Closed Funds checkbox to indicate that you wish to list closed 

funds as well.  

Because planned gifts are not included in the Donor Acknowledgement Report, the Include Planned Gift 

Designations checkbox does not apply. 

After your selections are complete, click the Apply Filter button (or hit the Enter key) to redisplay the Fund List & 

Information page with funds that match your selections. To remove your filtering choices and redisplay the full list of 

funds, click the Refresh Fund List button found on the Fund List & Information page. 

Generating the Donor Acknowledgement Report 

After selecting one or more funds to include in the report, use the area below the fund list to select the Donor 

Acknowledgement report, then click the Submit button:  

 

Supplying Report Parameters 

When the Submit button is clicked, a new browser tab appears to collect your report parameters: 
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Use the parameters to select the fund gifts to include in the report. The first three fields are required. 

Date Selection Type 

Date Entered – Include gifts based upon the date they were entered in the ABE CRM system. This is 

the recommended choice, and the default. It is the best way to assure that your report will return all 

gifts entered for the reporting period, regardless of the transaction date.  

Transaction Post Date – Include gifts based upon the date they were received by the WFAA. 

Generally, this aligns with the date a person made their gift online or the date gifts arrive at the 

lockbox or WFAA offices. 

Begin Date 

End Date  

The date range of gifts to include, following the criteria specified in the Date Selection Type field. 

Dates must be within the last 15 months. 

Minimum Gift Amount  

Limits the gifts to those having a dollar value equal to or greater than the value entered.  

Maximum Gift Amount  

Limits the gifts to those having a dollar value equal to or less than the value entered.  

Constituent Type  

Provides the option to limit the report to gifts from Individuals or gifts from Organizations. By 

default, All gifts are included in the report. 

Exclude Tribute Gifts  
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Check this box to not include gifts made in tribute or in memoriam. 

List Alum From This School/College/Unit First when Constituents are Spouse-Linked 

This selection is only applied to jointly given gifts. By default, the donor who received the revenue 

credit is the Constituent and their partner is the Spouse. Use this field to indicate your preference to 

list the alumnus from your unit as the Constituent.  

Report Type 

There are two report types. The standard type contains information most frequently required to 

thank donors for their gifts. The expanded type includes additional donor and gift information which 

may be useful when organizing your acknowledgements (e.g. by Region) or personalizing a donor 

message. (A description of standard and expanded data fields is provided later in this document.) 

 

Standard – Web displays gift data in your browser. Once displayed, you can request that an Excel 

version of the report be generated. A link to the report will be emailed to you. 

 

The Standard – Excel and Expanded – Excel options do not display data in your browser. Instead, a 

link to the generated Excel report is emailed to you.  

Generating the Report 

After supplying your report parameters, click the Create Report button. Generating the report may take some time 

depending on the version of the report that you have requested, the begin/end date parameters, and the number of 

funds you have selected.  

Standard – Excel Reports and Extended – Excel Reports 

After you click the Create Report button, you will be shown a message confirming the report type and where the 

report email will be sent: 

 

The email will include a link to download the Excel file. To download, you must be logged into the Advancement 

Resources website. (If you are not logged in, you will be prompted to. After logging in, the file will immediately 

download.) 
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Standard – Web Reports 

When a Standard – Web report is generated, a list of gifts and their donors is shown: 

 

Click the column headers to sort the gift/donor entries by values in that column. 

The table displays a subset of standard gift and donor information. Use the Export All Details to Excel button to 

generate a report that contains all standard fields and have it mailed to you. (See the previous section.) 

Click a gift’s Details link to display all data related to the gift. The data will display at the bottom of the page: 
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(An explanation of the data fields is in the next section.) 

The links open a new tab in your browser to display detailed information stored in ABE CRM. The fund information 

link is inoperable to campus users. Campus users can access fund details via the Advancement Resources website. 
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Donor Acknowledgement Report – Data Fields 

The data fields provided by the Donor Acknowledgement Report are described in the table below. 

A constituent may have expressed that they wish to limit various types of contact. If so, respective contact 

information will be blank: 

 Do Not Mail – Address information is left blank. 

 Do Not Email – Email information is left blank. 

 Do Not Call – Phone information is left blank. 
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Here is an alphabetical list of the report fields. In the rightmost column, an S indicates that the field is found in the 

Standard and Expanded report. An E indicates a field that is only found in the Expanded report. 

Name Description  

Acknowledgement Date 
(mm/dd/yyyy) 

Used to submit acknowledgement activity information to the WFAA. 
Supply the date that an acknowledgement was sent for this gift.  S 

Acknowledgement Exists 
Indicates whether the transaction has corresponding 
Acknowledgements stored in ABE CRM. S 

Acknowledgement Type 
Used to submit acknowledgement activity information to the WFAA. It 
provides a pull-down menu to select the type of acknowledgement 
sent for this gift.  S 

Additional Information Explains that the donor has provided a specific intent for how the gift is 
to be used beyond the general funding purpose of the receiving Fund.  S 

Address1 
Address2 
Address3 
Address4 
Address5 

The donor's address 

S 
S 
S 
S 
S 

Addressee The name used in the address of postal correspondence with the 
constituent. S 

Appeal Describes the solicitation effort that prompted this gift. S 

Boards/Councils/Committees The boards, councils, and committees of which the donor is a member. 
Includes an indicator of current or past membership. E 

City The donor's city. S 
Constituent First Name The donor's first name. S 
Constituent ID A unique ID assigned to the donor. S 
Constituent Last Name The donor's last name, or the name of an organization. S 
Country The donor's country. S 
Date Entered The date the gift record was created in ABE. S 
Degree Major The donor's major for their primary (initial) degree at UW Madison. E 

Degree Type The type of degree the donor earned in their primary (initial) degree at 
UW Madison. E 

Degree Year The year the donor earned their primary (initial) degree at UW 
Madison. E 

Department Name The campus/school department associated with the fund. S 

Development Staff 
A list of those who engage in development efforts with the donor, 
including any Primary Managers, Secondary Managers, Secondary 
Solicitors, and Interaction Owners. E 

Division 
The Development Director who raises money for the Unit and 
Department associated with the fund. (Not all funds have a Division 
assignment.) S 

Donor Directed Organization Name Name of the organization (i.e. Trust or Foundation) that has given the 
gift on behalf of the donor. E 

Donor Gave to Other Funds within 
Unit? (Household) 

For the reporting period, indicates whether the donor made an 
outright gift, new pledge, pledge payment, recurring gift initiation, or 
recurring gift payment to other funds within the same 
unit/school/college as this gift. (Excludes memberships, event 
registrations, and anonymous gifts.) E 

Email The donor's primary email address. S 
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Final Pledge Payment Indicates whether the payment is the final payment on a pledge. S 

First Gift To Department? 
Indicates whether the gift is the first time the donor (or either donor in 
the case of a joint gift) has given to the Department. Does not consider 
new pledges or recurring gift initiations. S 

First Gift To Fund? 
Indicates whether the gift is the first time the donor (or either donor in 
the case of a joint gift) has given to the Fund. Does not consider new 
pledges or recurring gift initiations. S 

First Gift To Unit? 
Indicates whether the gift is the first time the donor (or either donor in 
the case of a joint gift) has given to the Unit. Does not consider new 
pledges or recurring gift initiations. S 

Fund Name The name of the fund receiving the gift. S 
Fund Number The number of the fund receiving the gift. S 

Fund Use The use of the fund receiving the gift (e.g. Discretionary, Endowed 
Chairs/Professorships, Research, Programs). S 

Gift Capacity Rating (Household) The estimated gift capacity for the donor's household. E 

Gift Type Description 

The type of gift that was received. Possible values are:  
Outright Gift; New Pledge; Pledge Payment; Recurring Gift Initiation (a 
commitment from a donor to give regularly with no specific end date); 
Recurring Gift Payment. S 

Gifts to Fund in Last 12 Months 
(Household) 

The number of gifts to this fund given by members of the household 
within the last 12 months. S 

Grateful Client? (Vet) Indicates if the donor is a grateful client of the Veterinary school. E 
Has Planned Gift For Site 
(Household) 

Indicates whether the donor's household has a planned gift 
commitment or payment toward the unit of the gift's fund. E 

Household Total Giving to Dept  Includes all giving to the fund's department, regardless of the report 
timeframe.  E 

Household Total Giving to Unit  Includes all giving to the fund's unit, regardless of the report 
timeframe.  E 

Match Qualification Code Shows the type of match for which the gift qualifies. E 
Nickname The donor's nickname, if available. E 
Payment Channel Indicates the channel through which the payment was received. S 

Payment Notes Indicates additional information regarding the donor's gift (e.g. 
attached to a specific research initiative). E 

Phone The donor's primary phone number. S 
Pledge Balance Amount as of 
Report Date 

The outstanding pledge balance for the day the report was generated 
(not the selected reporting period). S 

Pledge Type If gift is a payment against a Pledge, indicates the type (e.g. Telefund 
Pledge, Automatic Deduction, Fixed Term). S 

QPQ Gift? Indicates that there was a benefit associated with this gift (Quid Pro 
Quo). E 

Reallocated Gift? 
Indicates that the gift has been reallocated. An example is when a gift 
is initially placed in an undesignated holding fund and later directed by 
the donor to a specific fund. S 

Recognition Preference 
This field only displays in the web version of the report, and only when 
the donor prefers no public recognition.  

Recognition Amount 
The amount of recognition credit for the gift. (Usually will equal the 
Transaction Amount. An example of a different value is for quid pro 
quo gifts.) S 
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Recognition Society Participant? Lists the names of lifetime recognition societies of which the donor is a 
member. E 

Region A geographical area determined by the constituent’s county or zip 
code. E 

Resident/Fellow Alum? Indicates if the donor is a UW Resident or Fellow. E 
Revenue Transaction ID A unique ID assigned to a received payment. S 

Salutation The name used when addressing the constituent within postal 
correspondence. S 

School College The school or college from which the donor earned their primary 
(initial) degree at UW Madison. E 

Spouse 
Boards/Councils/Committees 

The boards, councils, and committees of which the spouse is a 
member. Includes an indicator of current or past membership. E 

Spouse Degree Major The spouse's major for their primary (initial) degree at UW Madison. E 

Spouse Degree Type The type of degree the spouse earned in their primary (initial) degree 
at UW Madison. E 

Spouse Degree Year The year the spouse earned their primary (initial) degree at UW 
Madison. E 

Spouse Email The spouse's primary email address. S 
Spouse First Name The spouse's first name. S 
Spouse ID A unique ID assigned to the spouse. S 
Spouse Last Name The spouse's last name. S 

Spouse School College The school or college from which the spouse earned their primary 
(initial) degree at UW Madison. E 

Spouse UW Degrees A list of the spouse's UW-Madison degrees. S 
State The donor's state. S 

Total Pledge If this is a new pledge or a payment against a Pledge, shows the 
amount of the original pledge initiation. S 

Transaction Amount 
The dollar value of the payment made. This may include a portion that 
is not tax deductible (e.g. value of a dinner for an event ticket 
purchase).  S 

Transaction Date The date the gift was received by US Bank or the WFAA for processing. S 
Tribute Indicates whether this is a tribute or memorial gift. S 
Tribute Notes Text describing the tribute if this is a tribute gift. S 
Unit Name The campus/school unit associated with the fund. S 
UW Degrees A list of the donor's UW-Madison degrees. S 
Zip The donor's zip code. S 
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Donor Acknowledgement Resources 

The Donor Acknowledgement Report identifies donors and their gifts, providing the necessary information to thank 

them. Campus and WFAA stakeholders have collaborated to develop baseline recommendations to ensure 

consistency in stewarding donors. These guidelines are available in a central repository called the Stewardship 

Toolkit, which is accessible via the Advancement Resources website: 

about.uwadvancement.org/development/stewardship-resources 

The Toolkit provides stewardship samples and best practices. Use the data provided by the Donor 

Acknowledgement Report and resources available in the Stewardship Toolkit to make the most of your 

acknowledgment efforts.   

Recording Acknowledgement Activity 

Another use of the Donor Acknowledgement Report is to record acknowledgement activity in ABE CRM. To learn 

how to use the report to record your acknowledgment activity, see the Viewing and Recording Gift 

Acknowledgement Activity in ABE document in the Stewardship Toolkit. 

Acknowledgement Letters can be stored in ABE CRM, and are tied to a specific revenue transaction. When one of 

the following acknowledgement types has been stored, a ‘Yes’ will display in the Acknowledgement Exists column 

for the gift: 

 General Acknowledgement 

 Coach/Celebrity/Spokesperson Acknowledgement 

 School/College/Unit Dean Acknowledgement 

 Physician/Caregiver Acknowledgement 

 DoD Acknowledgement 

 Volunteer Acknowledgement 

 Student Acknowledgement 

 Chancellor Acknowledgement 

 First Time Donor Acknowledgement 

 Faculty/Chair/Director Acknowledgement 

 WFAA Executive Acknowledgement 

 Other School/College/Unit Leadership Acknowledgement 

 
  

https://about.uwadvancement.org/development/stewardship-resources/
https://about.uwadvancement.org/wp-content/uploads/Recording-gift-acknowledgement-activity-in-ABE-1.pdf
https://about.uwadvancement.org/wp-content/uploads/Recording-gift-acknowledgement-activity-in-ABE-1.pdf
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Using Excel to Manage the Donor Acknowledgement Report 

The Donor Acknowledgement Report supplies a large amount of data. It can be a daunting task to make sense of the 

supplied information. 

The data can be displayed in your browser, but your view will be limited. The most useful way to work with the data 

is by using a spreadsheet application like Excel. With Excel, you have the capability to organize your data and control 

how the data is displayed. The following sections contain common examples of using Excel to make the most of the 

Donor Acknowledgement Report data. 

(Note: The General Excel Tips section at the end of this guide is a short primer on basic Excel skills. And don’t forget 

the Internet, where you may find countless articles on how to accomplish both simple and complex Excel tasks.) 

Identifying Gifts Having Multiple Donors 

In the Donor Acknowledgement Report, each gift is usually represented by a single row of data. Each row describes 

the donor (and their spouse/partner, if applicable). However, some gifts are represented by multiple rows (e.g. gifts 

from siblings, gifts from parents and their children). If you wish to easily identify gifts in the latter category, you can 

use Excel sorting and conditional formatting. 

Sorting 

The most straightforward way to identify all donors of a particular gift is to sort the data by Revenue Transaction ID. 

(See the Links in Report Data section above and the sorting discussion in the General Excel Tips section at the end of 

this guide.) Once sorted, each gift’s entries appear together: 

 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13267145 8-10449999 Johnson Don    $400.00  

rev-13290401 8-10332222 Hall Jim    $1500.00  

rev-13469999 8-10779456 Patterson Gary 8-1329611 Patterson Elle $5,000.00 ABC Company 

rev-13469999 8-10326814 Anderson Mary    $5,000.00 ABC Company 

rev-13877777 8-10223344 Williams Jane    $1,000.00  

 

As you scan the Revenue Transaction ID column, you will notice three different values. The third value 

(rev-13469999) appears twice, indicating that these entries define the donors of a single gift. 

Conditional Formatting 

Unfortunately, it is difficult to look at a column of Revenue Transaction IDs and distinguish one value from another. 

One way to make things a bit easier is to apply conditional formatting to the Revenue Transaction ID column. (See 

the Highlighting Duplicate Fields discussion in the General Excel Tips section at the end of this guide.) In the report 

example below, conditional formatting has been used to highlight duplicate IDs: 
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Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13267145 8-10449999 Johnson Don    $400.00  

rev-13290401 8-10332222 Hall Jim    $1500.00  

rev-13469999 8-10779456 Patterson Gary 8-1329611 Patterson Elle $5,000.00 ABC Company 

rev-13469999 8-10326814 Anderson Mary    $5,000.00 ABC Company 

rev-13877777 8-10223344 Williams Jane    $1,000.00  

 

Now you can easily know when an entry is part of a group of donor entries. 

Applying this kind of conditional formatting to the Revenue Transaction ID column has other advantages. Here is the 

same conditionally-formatted data, now sorted by Constituent Last Name: 

Revenue 
Transaction ID 

Constituent 
ID 

Constituent 
Last Name 

Constituent 
First Name 

Spouse ID 
Spouse 

Last Name 

Spouse 
First 

Name 

Recognition 
Amount 

Donor Directed 
Organization 

Name 

rev-13469999 8-10326814 Anderson Mary    $5,000.00 ABC Company 

rev-13290401 8-10332222 Hall Jim    $1500.00  

rev-13267145 8-10449999 Johnson Don    $400.00  

rev-13469999 8-10779456 Patterson Gary 8-1329611 Patterson Elle $5,000.00 ABC Company 

rev-13877777 8-10223344 Williams Jane    $1,000.00  

 

When looking at this data, you’ve retained the ability to know whether a gift entry has additional donor entries, 

even when the gifts are sorted in a different order. 

Limiting the Display to Gifts That Meet Particular Criteria 

When you generate a Donor Acknowledgement Report, you must select one or more funds and provide a date range 

of giving. After the report has been generated, you can use Excel to limit the report entries to gifts that meet 

additional conditions. Perhaps you wish to only see gifts greater than $1000, or from donors in California, or those 

that are a donor’s first gift to a particular fund. 

Filtering 

Use Excel filtering to limit the display to data that meets your criteria. (The data that doesn't meet your criteria is 

hidden, not removed.) When you activate a filter, each column provides a drop-down menu to make your criteria 

selection. Here is what is displayed when the filter is activated (only a subset of fields is shown in this example): 
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If you wished to limit the entries based on Amount, you’d click the arrow in that column. This will provide a means 

to display Amounts corresponding to a particular value or meeting criteria you supply: 
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Use the checkboxes to select criteria for the entries you wish to display. If only Matching Company is checked, here 

is the result: 

 

Note that a column that has been filtered displays the  icon in its heading. 

 

Limiting the Columns That Display 

The Donor Acknowledgement Report contains over four dozen columns of data. It may be useful to “hide” data 

columns that are not important to the task at hand. 

To hide one or more columns, select the columns by clicking the column header (e.g. A, B, C). Once your columns 

have been selected, place your cursor in a selected area and do a right-click. A popup menu will appear. Select Hide 

to remove the columns from the display. 

To unhide (redisplay) the columns, select the columns surrounding the hidden column (or click the  cell in the 

upper left hand corner of your spreadsheet to select all columns). Once selected, place your cursor in a selected area 

and do a right-click. Select Unhide from the popup menu. 

Controlling Which Rows and Columns to Keep in View 

Because of the large number of columns (and perhaps rows) in your Donor Acknowledgement Report spreadsheet, it 

is unlikely that you will be able to keep all data in view. This can make your work difficult. For example, when you 

scroll down through rows of data, the report headings will scroll off the page. When you scroll through the columns 

of a donor’s record, their name will scroll out of the visible area. 

You can address these difficulties through freeze panes. A freeze pane allows you to “secure” rows and/or columns 

in place so that they will stay in view at all times, no matter how you scroll through the worksheet. 

Freezing the Header 

The most common use of freeze panes is to secure the heading (the top row of the report). To freeze the row, go to 

the View menu, select the Freeze Panes button, and then click the Freeze Top Row button: 
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When this is done, your rows of data will scroll but the heading will remain in place. 

Freezing the Header and Leftmost Columns 

Another common use of freeze panes is to secure the heading and the donor’s name. Here is an example of a report 

spreadsheet (some columns have been hidden – see the previous section, Limiting the Columns to Display): 

 

If the heading (row 1) and the first three columns (A, C, and D) remain in place as the remaining data is scrolled, you 

will always know what data you are looking at and who the data is associated with. 

To accomplish this, you must first “unfreeze” any rows/columns that have been frozen. Go to the View menu, select 

the Freeze Panes button, and then click the Unfreeze Panes. (If the Unfreeze Panes option is not presented, no 

rows/columns have been frozen.) 

To “freeze” the heading and first three columns, identify the row immediately below the row you wish to freeze 

(row 2) and the column immediately to the right of the columns you wish to freeze (column K in this example). Click 

the cell at the intersection of the two: 



Advancement Resources – Donor Acknowledgement Report Page 28 
 

 

With the cell selected, go to the View menu, select the Freeze Panes button, and then click the Freeze Panes 

button. You have “secured” the heading and first three columns in place. 

Viewing Long Text 

When text exceeds a column width, it is possible to automatically wrap the text. For example, the UW Degrees 

column “spills” into the Spouse UW Degrees column: 

 

To better view the column contents, select the column (AV in our example). On the Home tab, in the Alignment 

group, click Wrap Text (see the circles below). Here is the result: 

 

If you change the column width, data wrapping adjusts automatically.  
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General Excel Tips 

To make the most of your Donor Acknowledgement data, take advantage of some of Excel’s simple but powerful 

features. 

Below are some examples of common features. Each example will use this data: 

 

Sorting 

To sort the file, click the  icon in the upper right corner to select the entire set of data. All data cells will be 

shaded. 

 

From the menu, select Data > Sort. A popup will display: 
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Be sure that the My data has headers checkbox (shown at the upper right) is checked. 

Click the Add Level button to choose the field you wish to sort by. After a field is selected, use the Order setting to 

specify whether you wish to see the data in ascending or descending order. 

You may add multiple levels of sorting. Consider these sort settings: 

 

The data will be sorted by city. Then for each city, the data will be sorted by age (oldest to youngest). Click OK to 

sort and redisplay the data: 

 

Each city is grouped together, and within each city the records appear in reverse age order. 
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Highlighting Duplicate Fields 

Often it is useful to know if the same value appears more than once in a column of data. Excel can determine this for 

you with conditional formatting. 

To start, select the column where you wish to find duplicate values. Do this by clicking the column letter (e.g. A, B, 

C). The entire column will be shaded: 

 

After the data has been selected, go to the menus and select Home > Conditional Formatting > Highlight Cells 

Rules > Duplicate Values…. A popup will appear providing different color schemes to highlight the duplicate values. 

 

Here is the data when the default scheme is selected: 
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Here you can see that the value 46 appears more than once in the Age column. 

Removing Duplicate Rows 

You can use Excel to remove “duplicate” rows. Duplicate rows are those that have matching data in one or more 

columns. It’s up to you to specify which columns should be used. For example, let’s say we wish to determine which 

cities are represented in our data. 

The easiest way to start the process is to click the  icon in the upper right corner to select the entire set of 

data. All data cells will be shaded. 

 

From the menu, select Data > Remove Duplicates. A popup will display: 
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Use the popup to define which data to use when determining duplicate rows. For our example, we will uncheck 

everything except City. Once this is done, clicking the OK button causes Excel to remove the “duplicates”: 

 

The result is a file where the City values appear only once, so we’ve determined that our file has three unique cities. 

Filtering 

When you filter data, you limit the display to data that meets your criteria. (The data that doesn't meet your criteria 

is hidden, not removed.) In our data example, let’s say we wish to only display Verona records. 

To start, click the  icon in the upper right corner to select the entire set of data. All data cells will be shaded. 

(As an alternative, you could select just the city column, because your goal is to filter by just that column’s data.) 

After the data has been selected, go to the menus and select Data > Filter. Each selected data column will have a 

 icon added to its heading: 
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When you click one of these arrow icons, a list of data values found in the column is shown. Here’s the display when 

the City column filter is clicked: 

 

Use the checkboxes to select which records to display. After your selections are made, click the OK button. A column 

that has been filtered will display the  icon in its heading. 
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Sum of a Column’s Values 

To tally the total value of data in a column. Excel provides a sum function. 

To start, select a cell below the column of values you wish to add. To add all Age values: 

 

After the cell has been selected, go to the menus and select Formulas > AutoSum > Sum. Excel will place a “sum 

formula in the cell: 

 

Hit the Enter key to display the sum in the selected cell: 
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